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1. INSTALLATION

Hardware Requirements:

Compatible PC Processor:
DX CPU or installed math coprocessor
SX CPU will not run VPAS

Memory:
4MBytes minimum
(although VPAS will typically run OK with 4M, Voltech will not 
guarantee it's reliability)
8MBytes recommended

Hard Disk Drive:
4MBytes free minimum

Video:
VGA 640x480 DPI resolution minimum.  Higher resolutions will allow 
the user to view more data simultaneously without having to move 
windows around.  1024x768 DPI allows the user to view virtually all 
data simultaneously.

Operating System:
Supported:

Windows 3.1
Windows 3.11 for Workgroups
Windows 95

Power Analyzer:
PM3000A - Firmware version 1.67 or above
PM3300 - Firmware version 1.67 or above

Power Analyzer to Computer interface:
RS232:

Comm. ports 1-4
IEEE-488:

All current National Instruments cards supporting 488.2 protocols
I.O. Tech with NATWIN driver
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Installing VPAS

1) Turn on your computer and run ‘Windows’.

2) Insert the VPAS setup disk into the computer floppy disk drive.

3) Select ‘RUN’ and choose ‘SETUP’ on the VPAS disk to start the 
installation process.

The VPAS installation program will prompt you to specify 2 directories, one
for the CVI Run-Time executable and one for VPAS.  If you have other
programs that were written in LabWindow/CVI, you should choose the same
Run-Time directory.

VPAS can be installed to any hard disk drive.

When installation is complete, a new program group called ‘Voltech
Software’ will appear on your computer desktop.

To run VPAS, simply double click on the VPAS icon found in the ‘Voltech
Software’ Program Group.

Please Note: Due to the complexity of VPAS it is not recommended to run 
any other applications while VPAS is running.  It is also not 
recommended to run VPAS while logged on to a network.
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2. RUNNING VPAS FOR THE FIRST TIME

After installing the VPAS software, run the software by double clicking on the
VPAS Icon.

If the message ‘Initializing DEF_LOAD.INI’ is displayed, this is OK.  Click on
OK so that VPAS can search for its run-time directory.  If this message continues
to be displayed, you should try re-installing the VPAS software.  If this message
still remains, contact Voltech for further assistance.

The display will show the prompt ‘PLEASE WAIT, INITIALIZING’.  During this
time the VPAS software is loading all of the settings from the setup file last used
by VPAS or the DEFAULT.SET if no previous setup file had been used.  The
current setup file is displayed after the title in the main VPAS title bar.

In this section, the software can be configured to run with a Power Analyzer
connected or by itself configured to DEMO mode.

1. Set Communications: With the mouse, select ‘Communications’ under the 
‘Configure’ menu.

In this window, the user chooses the type of interface to the Power Analyzer.
For now, select DEMO as the ‘Interface Type.’  Even if there is a Power
Analyzer connected to the computer, you should select DEMO mode since
the software will run faster during this demonstration.  DEMO mode will
simulate a Power Analyzer as though you had one connected to the computer.

Additional information on setting communication parameters can be found in
the section titled ‘Configure Menu -> Communications.’  Click on
‘ACCEPT’ to accept the currently shown settings.

2. Set Input Configuration: Click on ‘Input Configuration’ under the 
‘Configure’ menu.

In this window you will setup the various possible input connections.  If you
intend to use VPAS with a PWM motor drive, you can click on the ‘PWM
Mode’ switch to toggle it from ‘Disable’ to ‘Enable.’  If ‘PWM Mode’ is
‘Enabled’, additional PWM settings become visible.  Here you can choose
‘Input’ or ‘Output’ connection to the motor drive.
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You can also select ‘Measure DC Bus’.  ‘ACCEPT’ the ‘Shunt Selection /
Scaling’ window.  Choose the ‘Wiring’ mode you wish to run the instrument
in.  With certain switch settings, the ‘Wiring’ mode will be forced to a valid
setting.  The software will automatically notify you when there is an invalid
‘Wiring’ selection.

If ‘PWM Mode’ is ‘Enabled’, the ‘Drive Fundamental Output Frequency’
parameters become visible.  If ‘Connection’ is set to ‘Input of Drive’,
‘Choose Frequency Range’ is invalid so it is dimmed.

If you have a PM3000A-001, the ‘Torque/Speed settings can be used’.  If you
click ‘Shunt / Scaling’, a new window is opened which allows you to
calibrate the results to reflect ‘TRUE’ conditions of the measurement rather
that what is being fed to the input of the Power Analyzer.  An example of this
would be a 1000 to 1 ratio current transformer used to measure high currents.
This window will only allow certain settings to be visible based on the
‘Wiring’ mode selected in the ‘Input Configuration’ window.  The
‘Averaging’ can be set from AUTO to 1-64.

The ‘Bandwidth’ can be set to either High or Low depending on the load
conditions.  Setting High will give the analyzer its’ 1MHz bandwidth,
however, this can allow noise to play a larger part in the results.  If Low is set
on a 002 Power Analyzer, the bandwidth drops to 4kHz, but all other Power
Analyzers will drop to 20kHz.

The ‘Frequency Source’ can be selected to have the Power Analyzer
synchronize on the ‘Voltage’ or ‘Current’ waveform or the an external input
can be used on the back of the Power Analyzer.

An in-depth description of all of these settings is listed in the section titled
‘Configure Menu -> Input Configuration’.

‘ACCEPT’ the Input Configuration window.

3. Select Measurement Parameters: Click on ‘Parameter Setup’ under the 
‘Configure’ menu.

This window allows you to choose the parameters you wish to measure.
There is no limit to the number of parameters that can be selected but keep in
mind that the more items that are selected, the longer it will take the Power
Analyzer to respond with its results, especially with a large number of
harmonics and/or a Series THD formula.
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In-depth information on this window can be found in the section titled
‘Configure Menu -> Parameter Setup’.

‘ACCEPT’ the Parameter Setup window.

4. Save / Load Setup:

All of the settings you set in steps 1-3 have been saved in the current .SET
file listed after the title on the top of the window.  Save the current settings in
another file which you will name by clicking on ‘Save Setup’ in the ‘File’
menu.  Enter up to an 8 character file name then click on ‘Save.’  After you
click Save in the Save Dialog box you will notice that the VPAS title
description now lists the file name you entered.  When you exit VPAS then
re-run it, VPAS will automatically load your setup file.  At any time you can
load a different setup file by choosing ‘Load Setup’ in the ‘File’ menu.

To save a graph or any other window to disk, use the [PrintScrn] key on your
keyboard to actuate the Windows Graphic Paste to Clipboard function.  This
allows the user to capture the entire VPAS window and paste it to the
clipboard.  You can then use Windows Paint or most other paint programs to
PASTE the object from the clipboard.  Finally you can save the file to disk in
any graphics format your paint program supports.

5. Measure Mode:

Now you are ready to start ‘Measuring’ data.  Click on ‘Measurement Mode’
in the ‘Measure’ menu.  This selection allows you to read back all of the
parameters selected in step 3 above.  All you will see is a blank screen with a
small box with four buttons.  The ‘Single Shot’ button will allow you to take
a single set of readings.

While the measurement is being taken, the LED next to the ‘Single Shot’
button will flash.  The ‘Auto’ button will continually trigger the Power
Analyzer until it is pressed a second time.  If at any time you have any
difficulties communicating with the Power Analyzer, click on the ‘Reset’
button which will re-initialize the Power Analyzer.

Anytime you are in ‘Measurement Mode’ if you click ‘CLOSE’,
‘Measurement Mode’ and any other opened ‘Show’ windows will close.
Click on the ‘Show’ menu and select any one or more windows to be
displayed.  If you choose ‘Show All’, all windows are opened.  If you choose
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‘Hide All’, all windows are closed.  Once you have one or more windows
opened, click on ‘Single Shot.’  Provided you have selected at least one
channel and at least one parameter in step 3, you will see the results displayed
in their appropriate window.

At anytime, if you wish, you can click on ‘Configure Menu -> Parameter
Setup’ and change your parameter selections.  This ability is disabled if you
are running in ‘Auto’ mode.

If you have not selected harmonics, the Harmonic Table, the Harmonic Bar
Spectrum, and the Inverse DFT Waveform windows will be dimmed.  Click
on the ‘Auto’ button and you will see the display continually update.  Click it
again to shut it off.

This concludes the demonstration on Measurement Mode.  Click ‘CLOSE’ to
the right of ‘Reset’ on the button bar.  In depth explanations on other features
within the ‘Show’ windows is given in the section titled ‘Show’ in this
manual.

6. Select Cycle by Cycle Parameters:

The Datalog Cycle by Cycle mode allows the user to measure various
parameters for every consecutive cycle up to 1860 cycles.  This mode is
typically used to profile the startup of a motor, power supply, etc.  The mode
is targeted for cycles of 400Hz or less.  You have the ability to measure up to
24 parameters maximum, i.e. Amps and Channels 1, 2, 3, Sum, and Neutral
would consist of 5 parameters.

Select ‘Cycle by Cycle Setup’ under the ‘Configure’ menu.  In the
‘Parameter’ box select the parameters you wish to read back from the Power
Analyzer.  Next, in the ‘Channels’ box, choose the channels you wish to
measure.  Valid channels are determined by the Input Wiring Selection in
step 2 above.

For any selected parameters you may choose to display a plot of the cycle by
cycle profile.  Choose the ‘Number of Cycles’ using the dial or enter it
directly into the ‘Number of Cycles’ box.  If you wish to display the table of
actual values for all cycles, enable the ‘Show Results Table’.  The plots will
start on the cycle defined in the ‘Start Plot on Cycle #’ entry.  This can be
useful since cycle 0 is defined as the synchronization cycle.  You will likely
find that the value of any parameter on cycle zero may be significantly
different from cycle 1 on, therefore to get better resolution on the plots start
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them on cycle #1.  The ‘# of Output Parameters’ simply signifies how many
parameters are currently selected to show you if too many parameters are
chosen (24 max.).

The ‘Trigger’ can be set to ‘Internal’ or ‘External’.  If you choose ‘External’,
the snapshot will not start until there is a contact closure on the External
Trigger BNC on the rear panel of the Power Analyzer.  ‘Internal’ trigger can
provide the ideal trigger since it doesn’t start until it sees a signal.  Due to
this, you can turn off your load, energize the cycle by cycle mode then turn
the load on and the Power Analyzer will track the cycle from that point.

The Power Analyzer will eventually trigger itself even if there is no signal
because it assumes that the signal is DC.  You have only a few seconds before
this happens.

Finally, due to the speed and the processing that must occur in this mode the
Power Analyzer cannot auto range so you must set appropriate ranges keeping
in mind that ranges are Peak NOT RMS.  If you are unsure, connect the load,
energize it then click on ‘Auto Sense Ranges’ and the software will determine
the appropriate ranges.  Occasionally you will have to increase the ranges
manually if the load causes intermittent peaks.  ‘ACCEPT’ the Cycle by
Cycle Datalog Setup.

7. Datalog Cycle by Cycle: Click on ‘Measure Menu -> Datalog Cycle by 
Cycle’.

You are now in Cycle by Cycle measurement mode.  ‘Auto’ is not a valid
selection in this mode so it is dimmed.  Click on ‘Single Shot’ which will
read back results and display them in a table and plot form depending on your
selections in step 6.  The table shows the results one cycle at a time.  You can
change the current cycle by rotating the dial or by manually entering the
desired cycle in the ‘Cycle #’ box.

The ‘Range Status’ indicators show whether the present cycle was valid (OK)
or whether any inputs were ‘OVER’ or ‘UNDER’ ranging, i.e. measuring a
5A signal with the Power Analyzer set to the 1APK range.  The parameters
affected by the ‘OVER’ or ‘UNDER’ range will be highlighted.

The plots will show the profile of any given parameter.  If you click the
mouse on any location on the plot, the cursor will jump to the closest cycle
value and will change the cycle on the table to the selected cycle and
highlight the appropriate value.
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Additional information on other features in the Cycle by Cycle mode are
detailed in the section titled ‘Measure Menu -> Datalog Cycle by Cycle.’
Click ‘CLOSE’ on the button bar to exit datalog mode and return to the
startup screen.

By now you should be familiar with the main modes in the VPAS software in
addition to the steps required to setup the modes.  The remaining sections in
this manual describe all features of the VPAS software in depth.
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3. FILE MENU
 

 

1. Load Setup:

This menu item allows the user to recall a setup file that has been previously
saved.

2. Save Setup:

This menu item allows the user to save the current setup to a user defined file
name.

The setup file consists of virtually all possible settings in the VPAS software
including parameter selections, input selections, window placement of all
windows, size of all windows, print settings, colors, etc.

To save a graph or any other window to disk, use the PrintScrn key on your
keyboard to actuate the Windows Graphic Paste to Clipboard function.  This
allows the user to capture the entire VPAS window and paste it to the
clipboard.  You can then use Windows Paint or most other paint programs to
PASTE the object from the clipboard.

Finally you can save the file to disk in any graphics format your paint
program supports.

3. Save Results:

This save feature is used to save all results returned from the ‘Measurement
Mode’ in either an ASCII or a CSV (Comma Separated Variable) format.

Upon selecting this menu item, the user will be prompted with a message box
allowing the user to enter a description of the test results.  The file will be
stamped with the time and date from the time of the measurement.  This item
is not used in the Cycle by Cycle mode.

To save a graph or any other window to disk, use the PrintScrn key on your
keyboard to actuate the Windows Graphic Paste to Clipboard function.  This
allows the user to capture the entire VPAS window and paste it to the
clipboard.  You can then use Windows Paint or most other paint programs to
PASTE the object from the clipboard.
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Finally, you can save the file to disk in any graphics format your paint
program supports.

4. Print Results:

This print feature is used to print all results returned from the ‘Measurement
Mode.’  Upon selecting this menu item, the user will be prompted with a
message box allowing the user to enter a description of the test results.  The
printout will be stamped with the time and date from the time of the
measurement.

This item is not used in the Cycle by Cycle mode.

5. Print Full Screen:

At any time, this item can be selected to graphically print the current VPAS
screen.  Graphic prints can be time consuming and cause the VPAS to be
slow at recognizing keystrokes and button clicks until the print is finished.

6. Exit:

As it implies, this menu item exits VPAS.  If the Power Analyzer is running
and data has not been stored, this selection will immediately initialize the
Power Analyzer and will exit VPAS without saving the data.  Be sure to
‘Save Results’, if desired,  before selecting this item.
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4. CONFIGURE MENU

1. Communications:

This menu item opens the Communication Configuration Window.

Interface Type:

DEMO:
This mode allows VPAS to simulate a Power Analyzer typically used for
demonstration and learning of the software since DEMO mode is quite fast.

IEEE488:
This mode sets up VPAS to communicate with either a PM3000A or a
PM3300 via a GPIB IEEE488 interface board.  Currently VPAS is known to
function properly with a National Instruments AT-GPIB-TNT board.  VPAS
should function properly with any GPIB board that fully supports the
IEEE488 command protocol (Send, Receive, etc.).  The driver that came with
the GPIB board to be used must be installed before it can be used with VPAS.

IEEE488 Instrument Address:
This address setting must match the setting of the Power Analyzer.  To set the
Power Analyzers address, on the PM3000A, press the INTERFACE key, then
using the SELECT and ENTER keys, choose IEEE488 then set the address.
On the PM3300, press the MENU key then, using the ARROW and ENTER
keys, choose INTERFACE, select IEEE488 and set the address.  The
IEEE488.2 setting is not important since VPAS forces it to IEEE488.2.

Note: Your instrument and board addresses must be different otherwise the
GPIB board will not work.

IEEE488 Board Address:
This address setting must match the setting on the GPIB board in the
computer.  If you are unsure of the board address of your GPIB board, contact
the manufacturer of your board who can help you find it.  National
Instruments typically default their boards to address 0.  IO-Tech typically
default their boards to address 21.

Note: Your instrument and board addresses must be different otherwise the
GPIB board will not work.
RS232:
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This mode sets up VPAS to communicate with either a PM3000A or a
PM3300 via a serial port.

RS232 Port:
Comm. ports 1-4 are supported.

RS232 Baud Rate:
VPAS supports all baud rates currently available on the PM3000A and the
PM3300.  You must be sure that the baud rate in VPAS matches the baud rate
setting on the Power Analyzer.  To set the Power Analyzers baud rate, on the
PM3000A, press the INTERFACE key then using the SELECT and ENTER
keys choose RS232 then select the appropriate baud rate.  On the PM3300,
press the MENU key then, using the ARROW and ENTER keys, select
RS232 and set the appropriate baud rate.  RS232 on the Power Analyzer must
be set to ‘Computer Control’.

Test Configuration:

This button will allow the user to test the currently selected communication
configuration.

The first prompt will ask the user if they wish to ‘Proceed with initialization of the
Power Analyzer.’  Verify that the setting shown is correct then choose YES.  If the
setting is incorrect choose NO.

After initializing the Power Analyzer VPAS will attempt to identify the Power
Analyzer.  After the identification you may get a message that you are working
with a version of firmware that VPAS was not written for.  This indicates that you
may run into problems such as trying to access functions that are not present in the
version of firmware in the analyzer.  You will be allowed to access all functions of
VPAS regardless of whether or not they are available in the firmware.

Upgrading the firmware is a simple procedure that can be done by the user by
simply calling Voltech and requesting the latest version of firmware.  If the Power
Analyzers version of firmware is higher than the version VPAS was written for,
listed in ‘About’ under the ‘Help’ menu, you are most likely OK.

Upon returning to the Communications Configuration window, if the test was
successful, the three boxes to the right of ‘Interface Type’ will contain the Model
of Power Analyzer, the Serial Number, and the current Version of Firmware.
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2. Set Time and Date:

This menu item opens the Set Time and Date window.

The ‘Current Time’ and ‘Current Date’ are continuously updated reflecting the
current settings of the real-time clock in the computer.  As the various boxes are
changed (Hours, Month, etc.) the ‘New Time’ and ‘New Date’ are updated.

Use the mouse to toggle the ‘AM/PM’ switch.  If the ‘12 Hour/24 Hour’ switch is
set to 24 Hour, the ‘AM/PM’ switch is dimmed and has no affect.  The format of
the date can be toggled to support different country formats.  The various saved
files and printouts will display the time and date at the top of the page.

It is important to realize that the time and date DOES NOT reflect the time and
date that the data was read but instead the time that the data was saved or printed.
Setting the real time clock under the ‘Control Panel’ in Windows or DOS has the
same effect.

3. Parameter Setup:

This menu item opens the Parameter Setup window.

This window allows the user to select the various parameters they wish to read
back from the Power Analyzer in ‘Measurement Mode.’  These settings have no
affect on ‘Cycle by Cycle mode.’

The user can also select the channels in addition to several options relating to the
parameters.  If ‘Fundamentals’ is selected, all of the valid parameters selected
above it will also be returned in their fundamental form.

Torque and Speed is only available on the PM3000A-001 and the PM3300 non -
002.  The PM3300-002 does not have torque and speed inputs.  Even though
Torque and Speed can be chosen at any time, if the Power Analyzer is not fitted
with the option, VPAS will return 0.0s.

In DEMO mode the maximum harmonic cannot exceed 7.
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4. Cycle by Cycle Setup:

This menu item opens the Cycle by Cycle Setup window.

This window allows the user to select the various settings for the ‘Cycle by Cycle
Mode.’  These settings have no affect on ‘Measurement Mode’.

Due to the speed intensive tasks that the Power Analyzer needs to accomplish,
Cycle by Cycle mode is targeted to be used on a signal between 5Hz and 400Hz.

Parameters:
These push buttons can be toggled depending on what parameters the user
wishes to read back.

Channels:
These push buttons can be toggled depending on what channels the user
wishes to read back.  The ‘Channels and Wiring’ selections in the ‘Input
Configuration’ window under the ‘Configure’ menu must be valid for the
channels selected.

Show Plot:
If the equivalent ‘Parameters’ button is ‘ON’ then the ‘Show Plot’ parameter
can be toggled.  If it is toggled to the ‘ON’ position than VPAS will display a
plot of that parameter.

Set Manual Range:
Due to the speed intensive requirements to read back data for every cycle and
simultaneously calculate all requested parameters, the Power Analyzer cannot
‘Auto’ range.  The user must choose a suitable range for Volts and Amps
keeping in mind that the ranging is Peak sensing NOT RMS.  If the user is
unsure of the range necessary to use the Cycle by Cycle mode properly, they
can connect and energize their load then click on the ‘Auto Sense Ranges’
button.  At this time VPAS will determine the appropriate range for the load
connected.

‘Auto Sense Ranges’ will usually pick the correct ranges, however in
circumstances where the load is unstable, it is possible to choose an incorrect
range.  In this case the user should select the ranges manually.  Looking at the
LED bars on the front of the Power Analyzer will give a good indication of
the maximum range that should be selected.
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Number of Cycles:
Cycle by Cycle mode will run for a duration of X ‘Number of Cycles’ where
X can be from 1 to 1860.  Keep in mind that 1860 cycle is a lot of data.  This
data could occupy up to about 500,000 bytes.  Transmitting that quantity of
data could take quite some time, easily 5-10 minutes using the RS232
interface.  Due to this speed issue, it is not recommended to choose a large
number of cycles unless it is specifically required.

Trigger:
The BNC on the back of the Power Analyzer can be used for triggering a start
of the Cycle by Cycle mode.  The Power Analyzer also has the ability to use
it’s internal trigger to start the Datalog mode.

A nice feature of the internal trigger is that it can sense when the load is
energized.  If the load is turned off and then the ‘Single Shot’ button is
clicked, the Power Analyzer will be initialized then will wait for the load to
be turned on and at that point the Cycle by Cycle mode will start analyzing.

The red status bar, only present while VPAS is acquiring data, will indicate
‘Energize Load’ at which point the user has only a few seconds to start the
load.  After this, even if the load is NOT ENERGIZED, the Power Analyzer
will start the Cycle by Cycle mode since it assumes that the signal connected
is a DC signal.  This means that the user has only a few seconds to energize
the load to get any useful results.

Show Results Table:
This button can be toggled to allow the user to show a table of the Cycle by
Cycle values.

Start Plot on Cycle #:
This is a useful value that allows the user to start all of the plots on a
specified cycle.  Cycle 0 is the cycle that the Power Analyzer uses to
synchronize on the applied signal.  Due to this, the values for cycle 0 may be
considerably different from the steady state value of any given parameter
which would yield poor resolution on the plot.

# of Output Parameters:
This value simply shows the number of parameters currently selected.  The
user may choose up to a maximum of 24 parameters, i.e. choosing Amps and
choosing Channels 1-3 and Sum and Neutral would consist of 5 parameters.

If the user selects more than 24 parameter, the ‘ACCEPT’ button becomes
dimmed and the user will not be allowed to accept the settings without



CONFIGURE MENU VPAS USER MANUAL

PAGE 16 VPN 98-008  V02  VOLTECH INSTRUMENTS

choosing a valid number of parameters.  The ‘Start Plot on Cycle #’ must
always be at least 1 less than the ‘Number of Cycles’ and is forced that way.

5. Input Configuration:

This menu item opens the Input Configuration window.  This window allows the
user to setup the various input connections to the Power Analyzer.  These settings
will be used in Measurement Mode and Cycle by Cycle Mode.

PWM Mode:
This switch will allow the user to enable or disable the ‘PWM Mode.’  This is
used solely for the purpose of using the Power Analyzer to measure a PWM
Motor Drive.  If the load is not a PWM Drive the this selection should be
disabled.  If Ballast Mode is Enabled while PWM Mode is enabled, PWM is
automatically be disabled since they cannot both be enabled at the same time.

Input / Output of Drive:
Input / Output of Drive can be toggled, if ‘PWM Mode’ is ‘Enabled’,
between ‘Input’ (measurement connection to the input of the motor drive
control unit) and ‘Output’ (measurement connection to the output of the
motor drive control unit).

Measure DC Bus:
Measure DC Bus can be toggled, if ‘PWM Mode’ is ‘Enabled’, to allow the
user to measure the DC Bus of the motor drive control unit.  If this item is
enabled, ‘Wiring’ will be forced to Independent Channel 3.  In this ‘Wiring’
mode, the 3 phase input or output of the drive must be connected in a 3 phase
3 wire configuration to channels 1 and 2 and the DC Bus must be connected
to channel 3.

It is useful to use the DC Bus as a reference where the user would measure
the input then the output of the drive then calculate the efficiency.  This
method becomes necessary when disconnecting from the input then
connecting to the output since the drive conditions may change.  This will
allow the user to get more accurate results with efficiency measurements.

Drive Fundamental Output Frequency:
These selections will be available only when ‘PWM Mode’ is ‘Enabled.’  If
the Power Analyzer connection is to the output of the drive than the user can
set either the ‘Frequency Range’ or the ‘Actual Frequency’ of the drive.
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The fundamental frequency is NOT the switching frequency of the drive,
instead it is typically equal to the speed of the motor.  The Power Analyzer
uses this value to properly synchronize to the PWM signal.  If the Power
Analyzer connection is to the input of the drive then the user must specify the
‘Actual Frequency’ of the fundamental drive OUTPUT.  This frequency is
used since the input frequency of the drive is modulated by the output
fundamental frequency of the drive.

Ballast Mode:
This switch will allow the user to enable or disable the ‘PWM Mode.’  This is
used solely for the purpose of using the Power Analyzer to measure a PWM
Motor Drive.  If the load is not a PWM Drive the this selection should be
disabled.

Torque/Speed:
Although these settings are always visible, they only have an affect if the
Power Analyzer is a PM3000A-001 or a standard PM3300.  If the Power
Analyzer is a PM3300-002, it does not have torque and speed inputs and will
result with all 0.0s.  In this configuration box, the user can select the desired
‘Units’ of torque and mechanical power results.

The scaling can also be set depending on the output of the transducers being
used.  The RPM input can also be toggled depending on whether the speed
transducer outputs pulses or a DC voltage.  If the speed transducer outputs
pulses, the pulses must be positive and negative going edges with a minimum
of 4Vpk to pk and a maximum of 20Vpk to pk.

Lastly, the DC voltage inputs for torque and speed can be set to a 0-1V full
scale or 0-10V full scale depending on the output range of the transducer
being used.  Accuracy of the 0-10V full scale setting will drop off below 1V.

Shunt / Scaling:
Clicking this button will open the Shunt Selection and Scaling window.

This window is used to compensate the results by applying a multiplier to the
results so that the results reflect the actual values of the load not the values on
the input of the Power Analyzer.

For example if the current was 500A, the user would have to use a transducer
which could be a current transformer, a hall effect device or a shunt.  If the
user was using a 1000 to 1 current transformer, such as the Voltech CT1000,
the output of the transformer would feed 500mA into the Power Analyzer
which would give a result of 500mA.  If the user selected a ‘Scale Ratio’ of
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1000 and sets the ‘Up/Down’ switch to ‘Up’, the Power Analyzer would give
a result of 500A which would also be reflected in Watts, VA, etc.

Alternatively, if the user was using a 1ohm shunt and feeding the external
shunt input on the Power Analyzer with the sense terminals across the shunt,
the user would first set the ‘Internal/External’ switch to ‘External’ and enter 1
into the ‘Shunt Value’ box.

Finally with a Hall Effect device, the user would again set the
‘Internal/External’ switch to ‘External’ and enter the Volts per Amp into the
‘Transducer/Hall Effect Output’ boxes.  Depending on the ‘Wiring’ selection,
only certain settings are valid in the Shunt Selection and Scaling window
which is why some boxes may be dimmed.

Averaging:
This selection allows the user to set the averaging of the Power Analyzer to
achieve higher stability and accuracy of the input signals.

The settings can be ‘Auto’ which sets the Power Analyzer to Auto mode or a
fixed averaging of 1-64.  In order to meet the Accuracy specs of the Power
Analyzer, this setting must be at least 8 or ‘Auto’, although the higher the
averaging setting, the longer it takes to read results back from the Power
Analyzer.

If Auto mode is selected, the Power Analyzer will take 16 averages, however
if the signal jumps, the averaging queue. of the Power Analyzer will reset,
unlike the fixed averaging mode.  This allows the results to change quickly
upon a change in input signal whereas the fixed mode would slowly average
the new input into the averaging queue.

Wiring:
This box will allow the user to select the wiring mode of the Power Analyzer.
The eight wiring modes are described in more detail in the Power Analyzer
user manual.  In certain configurations, the wiring will be automatically
changed due to an invalid selection.

Input Frequency Source:
This selection allows the user to set the source to be used for synchronization.

The source can be the Voltage, Current, External, or Slow External.  Most
applications will do just fine with Voltage as the frequency source.
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In a PWM application, the Voltage is a very distorted signal with high
frequency switching components which yield a relatively sinusoidal Current
signal.  In this case Current would be the desirable frequency source.

The user can also connect a signal to the external frequency input of the
Power Analyzer.  Although rare, it may be difficult to synchronize on the
Voltage or the Current where the external frequency is the best solution.

Bandwidth:
This selection allows the user to send the inputs through a hardware filter
built into the Power Analyzer.

If the Bandwidth is set to Low, the hardware filter is used.  If the Bandwidth
is set to high, the hardware filter is bypassed so that the Power Analyzer will
achieve it’s 1MHz bandwidth.

There can be times where high frequency noise can create synchronization
difficulties.  In these cases, it is best to set the bandwidth on Low.  All Power
Analyzers with a -002 option has a 4KHz filter installed for low bandwidth.
All other Power Analyzer options utilize a 20KHz filter for low bandwidth.

Zero Blanking:
This selection allows the user to enable or disable zero blanking.

The purpose for zero blanking is that below 10% of any given range, the
reading will be outside of the accuracy range of the Power Analyzer.  If Zero
Blanking is enabled, values below 10% of the range will read as 0.000 where
as with Zero Blanking disabled, you will get a reading but it will not be
within the accuracy specification.
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5. MEASURE MENU

1. Measurement Mode:

This menu selection sets VPAS into Measurement acquisition mode.

This mode is used to read back the parameters selected in the ‘Parameter Setup’
window in the ‘Configuration’ menu.  The user will be able to display RMS,
Fundamental, and Harmonic data in table format.

In addition, harmonics can be displayed as a ‘Harmonic Bar Spectrum’ and as a
‘Inverse DFT Waveform.’  The menu items which are valid in this mode of
operation are ‘Save Results’, ‘Print Results’, and ‘Print Full Screen’ under the
‘File’ menu and all of the menu items under the ‘Show’ menu.

‘Save Results’ and ‘Print Results’ will allow the user to save or print all the results
in an ASCII .TXT format.  "Save Results" will also allow the user save all the
results in a .CSV format.  ‘Print Full Screen’ will allow the user to graphically
print the full VPAS screen of windows as they are shown.  This is a low resolution
print.

The ‘Harmonic Bar Spectrum’ and the ‘Inverse DFT Waveform’ have their own
menu items that allow the user to print the plots in a variety of resolutions.

Button Bar:
The button bar is the row of push buttons at the top the VPAS window.  The
functions of the buttons are as follows:

Single Shot:
Allows the user to read back one set of results.

LED:
The LED next to the Single Shot button flashes while VPAS is acquiring
data.

Auto:
Sets VPAS to continually read results as fast as possible.

Reset:
If at any time there is a communications problem this button will force
the Power Analyzer to be initialized.  If this does not solve the
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communication problem the power to the Power Analyzer should be
cycled.

CLOSE:
This button will immediately close all windows and return VPAS to the
blank startup screen without allowing the user to save or print any
currently displayed results.

Show:
The ‘Show’ menu items will allow the user to display various windows with
various pieces of information.

Selecting a ‘Show’ menu item, such as RMS, will toggle the RMS window.
If the menu item is not checked and the user clicks on it the appropriate
window will be opened and the menu item will become checked.

Inversely, if the menu item is checked, and the user clicks on it, the window
will be closed and the check will be removed.  The user also has the option of
clicking ‘Show All’ which will open all the windows listed below and
clicking on ‘Hide All’ will close all the windows that are currently opened.

Below is a summary of the various windows and their additional functions.

RMS:
This menu item will toggle the RMS data results window.

This window will display the RMS results in addition to the Torque and
Speed results selected in the ‘Parameter Setup’ window under the
‘Configure’ menu.  Clicking on the ‘CLOSE’ button has the same affect
as clicking on the ‘RMS’ menu item under the ‘Show’ menu.

Fundamental:
This menu item will toggle the Fundamental data results window.

This window will display the Fundamental results of the parameters
selected in the ‘Parameter Setup’ window under the ‘Configure’ menu.
Clicking on the ‘CLOSE’ button has the same affect as clicking on the
‘Fundamental’ menu item under the ‘Show’ menu.

Harmonic Table:
This menu item will toggle the Harmonic Table results window.
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This window will display the harmonic result values in a scrollable
window.  The text line above the display window signifies the harmonic
number (Harm#), the absolute value of the harmonic magnitude (abs),
the percent of the harmonic magnitude as related to the magnitude of the
fundamental (%fund) and the phase angle of the harmonic (phase),
typically referenced back to the Voltage on Channel 1.

The reference of the phase angle will not be channel 1 if the wiring
mode is Channel 2 Only (channel 2 voltage reference), channel 3 only
(channel 3 voltage reference), Independent Channel 3 (channel 1 voltage
reference for 3 phase results on channels 1 and 2, and channel 3 voltage
reference for channel 3 results), and All Independent (each channel is
reference back to it’s own voltage).

Show Channels:
This row of push buttons allow the user to instantaneously add or
remove all harmonic results for a given channel.  This can be useful in
allowing the results to be easier to view for certain situations.

Update Speed:
This switch can be toggled from ‘Fast’ to ‘Slow’.

If it is set to ‘Fast’, when the window is updated it will close up to only
one line which will allow the harmonics to be filled into the window
much quicker.  This doesn’t have much of an affect when measuring
only a few harmonics.  However, if 99 harmonics are selected for all
channels, there can be a significant speed advantage to having this
switch set to ‘Fast’.

CLOSE:
Has the same affect as clicking on the menu item ‘Harmonic Table’
under the ‘Show’ menu.

Harmonic Bar Spectrum:
This menu item will toggle the Harmonic Bar Spectrum window.

This window will display the Harmonic results in a Harmonic Bar Spectrum
format.  The Y axis will display the harmonic parameter currently selected in
the ‘View’ menu.  The X axis will display the harmonic number.  The X axis
number placement indicates the CH1 harmonics, with the other channels to
the right of the table.
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Keep in mind that harmonic #0 is the DC component and harmonic #1 is the
fundamental component of the harmonic parameter selected in the ‘View’
menu.  The label for the harmonic number is at the location of Channel 1.  To
the right of each label are Channel 2, Channel 3. and Neutral, respectively.

The menu item ‘Print Full Screen’ under the main VPAS ‘File’ menu will
allow the user to graphically print the Harmonic Bar Spectrum window in
addition to any other windows current displayed as they are displayed in the
main VPAS window.

Zoom and Offset controls:
There are 4 slider controls displayed on the window border named
‘ZOOM’ and ‘OFFSET.’  The zoom controls will allow the user to zoom
in and out of the Harmonic Bar Spectrum plot in the X and Y directions.
The offset controls will allow the user to offset the Harmonic Bar
Spectrum in the X and Y directions.

These controls, used together, will allow the user to zoom in on virtually
any point on the graph.  This can be useful when trying to view
harmonics with a small magnitude.  This becomes very useful when the
fundamental ‘swamps’ out the other harmonics.  At any time the user
can reset the plot back to the default zoom values by clicking on the
‘Reset Zoom’ item in the ‘View’ menu.

Cursor:
By clicking on a harmonic bar, the cursor will jump to the value of that
harmonic and will display text above the plot listing the channel,
harmonic #, the absolute value, and the percent of the fundamental.
Once selected, the keyboard arrow keys will increment and decrement
the harmonic number on the plot.

Menu Items:
File:

Print: Opens the ‘Print Control Panel’ window.  This window is 
described in the section ‘Print Control Panel.’

Close: Same affect as clicking ‘Harmonic Bar Spectrum’ in the 
‘Show’ menu.

View:
In the View menu, the Channel items can individually be selected alone
or in any combination.  The parameter selections can only be selected
individually.  If the Channel or Parameter is not Selected in the
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‘Parameter Setup’ window under the ‘Configuration’ menu, it will be
dimmed and cannot be selected.

Full Screen: Expands the plot to cover the full 
VPAS window.

Normal: Restores the plot to the original 
‘windowed’ size.

Reset Zoom: Reset the zoom and offset controls to 
the default settings.

Channel 1: Toggles Channel 1 Harmonic Bar 
Spectrum.

Channel 2: Toggles Channel 2 Harmonic Bar 
Spectrum.

Channel 3: Toggles Channel 3 Harmonic Bar 
Spectrum.

Channel Neutral: Toggles Channel Neutral Harmonic Bar
Spectrum.

Show All Channels: Displays all Harmonic Bar Spectrums.
Hide All Channels: Hides all Harmonic Bar Spectrums
Volts: Displays the Volts Harmonic Bar 

Spectrum.
Amps: Displays the Amps Harmonic Bar 

Spectrum.
Watts: Displays the Watts Harmonic Bar 

Spectrum.
(only available if both Amps and Volts 
have been selected in the ‘Parameter 
Setup’ window under the 
‘Configuration’ menu.)

Exclude DC (H0): Remove all H0 harmonics from the 
spectrum.

Exclude Fundamental (H1): Remove all H1 harmonics from the 
spectrum.

(The exclude selections above can be useful if the fundamentals or
DC components are ‘swamping out’ the remaining harmonics.  By
excluding them, the plot will have better resolution.)

Settings:
Color:
The color menu items shown below can be individually changed to
suit the users preference.  Any color item that is changed will be
reflected in both the ‘Harmonic Bar Spectrum’ window AND the
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‘Inverse DFT Waveform’ window.  They cannot be selected
individually.  Any color changes will be stored in the currently
selected ‘Setup’ file (shown after the VPAS title in the title bar).

Channel 1 Trace
Channel 2 Trace
Channel 3 Trace
Channel Neutral Trace
Trace Background
Frame
Grid
Cursor

Inverse DFT Waveform:
This menu item will toggle the Inverse DFT Waveform window.

This window will display the Harmonic results in an Inverse DFT Waveform
format.  This means that the individual harmonics undergo calculations using
Inverse Discrete Fourier Transforms to generate the points for the waveforms
shown

This waveform could look significantly different than the actual waveform as
displayed on an oscilloscope if the waveform has frequency components
above the maximum harmonic, selected in the Configure -> Parameters menu
item, such as with the voltage waveform of the output of a PWM Drive.

Most applications will yield a ‘true’ representation of the actual waveform.
The Y axis will display the currently selected harmonic parameter in the
‘View’ menu.  The X axis will display the waveform position in degrees.

The menu item ‘Print Full Screen’ under the main VPAS ‘File’ menu will
allow the user to graphically print the Inverse DFT Waveform window in
addition to any other windows currently displayed as they are displayed in the
main VPAS window.

Zoom and Offset controls:
There are 4 slider controls displayed on the window border named
‘ZOOM’ and ‘OFFSET.’  The zoom controls will allow the user to zoom
in and out of the Inverse DFT Waveform plot in the X and Y directions.
The offset controls will allow the user to offset the Inverse DFT
Waveform in the X and Y directions.  These controls, used together, will
allow the user to zoom in on virtually any point on the graph.  This can
be useful when trying to view small changes in the waveform.  At any
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time the user can reset the plot back to the default zoom values by
clicking on the ‘Reset Zoom’ item in the ‘View’ menu.

Cursor:
By clicking on the waveform, the cursor will jump to the nearest
actual point of the waveform and will display text above the plot,
listing the channel and the value of the point.

Menu Items:
File:

Print: Opens the ‘Print Control Panel’ window.  This window is 
described in the section ‘Print Control Panel.’

Close: Same affect as clicking ‘Inverse DFT Waveform’ in the 
‘Show’ menu.

View:
In the View menu, the Channel items can individually be select alone or
in any combination.  The parameter selections can only be selected
individually.  If the Channel or Parameter is not selected in the
‘Parameter Setup’ window under the ‘Configuration’ menu, it will be
dimmed and cannot be selected.

Full Screen: Expands the plot to cover the full VPAS 
window.

Normal: Reduces the plot to the original 
‘windowed’ size.

Reset Zoom: Reset the zoom and offset controls to the 
default settings.

Channel 1: Toggles Channel 1 Inverse DFT 
Waveform.

Channel 2: Toggles Channel 2 Inverse DFT 
Waveform.

Channel 3: Toggles Channel 3 Inverse DFT 
Waveform.

Channel Neutral: Toggles Channel Neutral Inverse DFT 
Waveform.

Show All Channels: Displays all Inverse DFT Waveforms.
Hide All Channels: Hides all Inverse DFT Waveforms.
Volts: Displays the Volts Inverse DFT 

Waveform.
Amps: Displays the Amps Inverse DFT 

Waveform.
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Watts: Displays the Watts Inverse DFT 
Waveform.
(only available if both Amps and Volts 
have been selected in the ‘Parameter 
Setup’ window under the ‘Configuration’
menu.)

Settings:
Color:
The color menu items shown below can be individually changed to
suit the users preference.  Any color item that is changed will be
reflected in both the ‘Harmonic Bar Spectrum’ window AND the
‘Inverse DFT Waveform’ window.  They cannot be selected
individually.  Any color changes will be store in the currently selected
‘Setup’ file (shown after the VPAS title in the title bar).  In addition,
the traces have different styles to help see them, especially on
printouts.

Channel 1 Trace (Style:  Solid)
Channel 2 Trace (Style:  Dot)
Channel 3 Trace (Style:  Dash)
Channel Neutral Trace (Style:  Dash Dot)
Trace Background
Frame
Grid
Cursor

Number Of Cycles:
Selecting this menu item will allow the user to display multiple cycles
of the waveform.  All cycles will be identical since they are derived
from the same harmonic content.

Tools:
Harmonic Adjustment:
This menu item opens the Harmonic Adjustment window.

This window allows the user to manipulate the harmonic content of
Inverse DFT Waveforms.  This can be useful as a circuit simulation
tool to determine how a waveform would look based on harmonic
changes.

The user has the ability to change the magnitude and phase of any one
or more harmonics.  If there is interest in seeing what the waveform
would look like if a hardware filter was installed on the load to
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remove the 3rd harmonic, for instance, the user can simply remove the
harmonic by setting the magnitude to 0.

When new data is taken all adjustments are cleared.  If VPAS is
taking data in the ‘Auto’ mode, the harmonics cannot be adjusted so
the menu item is dimmed until the ‘Auto’ mode is ‘Stopped’.
If VPAS is idle with the Harmonic Adjustment window opened and
the user clicks on ‘Auto’, the Harmonic Adjustment window and the
menu item are dimmed until the ‘Auto’ mode is ‘Stopped’.

Harmonic:
This adjustment allows the user to select the desired harmonic to be
adjusted using the dial or manually entering the number into the
‘Harmonic’ box.

Phase:
This adjustment allows the user to adjust the phase of the harmonic
shown in the ‘Harmonic’ box.

The phase angle of the harmonic is typically referenced back to the
Voltage on Channel 1 (phase).  The reference of the phase angle
will not be channel 1 if the wiring mode is Channel 2 Only
(channel 2 voltage reference), channel 3 only (channel 3 voltage
reference), Independent Channel 3 (channel 1 voltage reference for
3 phase results on channels 1 and 2, and channel 3 voltage
reference for channel 3 results), and All Independent (each channel
is reference back to it’s own voltage).

Magnitude:
This adjustment allows the user to adjust the magnitude of the
harmonic shown in the ‘Harmonic’ box.  The harmonic can be
‘removed’ by setting the magnitude to 0.

Channel:
This box sets the channel of the harmonic to be adjusted.

Reset Single Harmonic:
This button will reset the parameters of the harmonic shown in the
‘Harmonic’ box back to it’s original values measured by the Power
Analyzer.
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RESET ALL:
This button will reset ALL harmonics back to their original values
measured by the Power Analyzer.

CLOSE:
This button closes the Harmonic Adjustment window.

Show All:
Open and display all 5 Measurement Mode windows.

Hide All:
Open and display all 5 Measurement Mode windows.

Datalog Cycle by Cycle:

This menu selection sets VPAS into Cycle by Cycle mode.

This mode is used to read back the parameters selected in the ‘Cycle by Cycle
Setup’ window under the ‘Configuration’ menu.  The user will be able to display a
table containing all of the parameter results for the number of cycles chosen.

In addition, parameters can be displayed in a ‘profile’ plot.  The menu item ‘Print
Full Screen’ under the main VPAS ‘File’ menu will allow the user to graphically
print all windows currently displayed as they are displayed in the main VPAS
window.

Button Bar:
The button bar is the row of push buttons at the top the VPAS window.  The
function of the buttons is as follows:

Single Shot:
Allows the user to read back one set of Cycle by Cycle results.

LED:
The LED next to the Single Shot button flashes while VPAS is acquiring
data.

Auto:
This button is disabled in Cycle by Cycle mode.

Reset:
If at any time there is a communications problem this button will force
the Power Analyzer to be initialized.  If this does not solve the
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communication problem the power to the Power Analyzer should be
cycled.

CLOSE:
This button will immediately close all windows and return VPAS to the
blank startup screen without allowing the user to save or print any
currently displayed results.

Cycle by Cycle table window:
This window displays the actual values of each of the parameters selected for
all of the cycles selected in the ‘Cycle by Cycle Setup’ window under the
‘Configuration’ menu item.  The Channel labels are outlined with their
appropriate trace color.  Additional window functions are as follows:

File:
Save:
To save a graph or any other window to disk, use the PrintScrn key on
your keyboard to actuate the Windows Graphic Paste to Clipboard
function.  This allows the user to capture the entire VPAS window
and paste it to the clipboard.  You can then use Windows Paint or
most other paint programs to PASTE the object from the clipboard.

Finally you can save the file to disk in any graphics format your paint
program supports.

ASCII:
This menu selection allows the user to save the data in an ASCII
.TXT format.  Upon selecting the ASCII menu item, a message box
will be displayed to allow the user to enter a brief description of the
data.  The top of the file will also be time and date stamped with the
actual time that the data was taken.

CSV:
This menu selection allows the user to save the data in a .CSV
(Comma Separated Variable) format.  This is a very common
format for most spreadsheets and other statistical analysis software
packages.  Once saved, the user could plot their own graphs among
other tasks in the software package of their choice.  Upon selecting
the CSV menu item, a message box will be displayed to allow the
user to enter a brief description of the data.  The top of the file will
also be time and date stamped with the actual time that the data was
taken.
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Print:
This menu selection prints the Cycle by Cycle data in an ASCII .TXT
format.

Close:
This selection will close the table window.

Cycle #:
This control sets the current cycle which can be changed via the dial or
by entering the Cycle number directly in the box.  The parameter data
will change to the chosen cycle.

Range Status:
These LED indicators will light depending on the Range Status.

If the current cycle, shown in the ‘Cycle #’ box, of data was measured
on the correct ranges, the ‘OK’ status indicator will be illuminated.  If
any of the data for the current cycle, shown in the ‘Cycle #’ box, is
invalid due to over or under ranging, the appropriate ‘OVER’ and/or
‘UNDER’ status indicators will illuminate and the relevant invalid
parameters will be highlighted with the color of the status indicator.

It is very common that cycle 0 data will contain invalid data since this is
the cycle that the Power Analyzer uses to synchronize on the inputs.  If
other cycles contain invalid data, this can typically be remedied by
appropriately changing the ‘Manual Range’ settings in the ‘Cycle by
Cycle Setup’ window under the ‘Configuration’ menu.

If the Channel 1 current range is set too low such that the current on this
channel is over ranging, all parameters for channel 1 except for Volts
will be highlighted indicating invalid data.  If the Channel 1 voltage
range is also over or under ranging, than the Volts for Channel 1 will
also be indicated to be invalid data.

Parameter Plot windows:
These windows are displayed for a single parameter for every parameter
selected in the ‘Cycle by Cycle Setup’ window under the ‘Configuration’
menu.

For example, if the user has selected the ‘Parameter’ Watts and has selected
the ‘Show Plot’ Watts, when a Cycle by Cycle acquisition is complete, a
‘Watts’ plot is displayed.  If the user has selected Channels 1-3 and Sum, all
4 traces will be displayed in the ‘Watts’ plot window.  In order to achieve
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better plot resolution, it may be desirable to disable some of the Channels in
the ‘Cycle by Cycle Setup’ window under the ‘Configure’ menu (such as Sum
and Neutral).

Cursor:
If the mouse is clicked on a trace in one of the plot windows, the cursor
jumps to the closest cycle value.  At the same time, if the table is shown,
the ‘Cycle #’ switches to the value pointed to by the cursor.  In addition,
the value that the cursor is pointing to is highlighted by the color of the
cursor.

Since the ‘Range Status’ indicators also highlight the parameters that are
‘OVER’ or ‘UNDER’ ranging, it is best to choose a cursor color that is not
‘Blue’ or ‘Red.’  The cursor color can be changed by selecting the ‘Cursor’
item under the ‘Settings->Color’ menu of the plot window.

File:
Print:
Opens the ‘Print Control Panel’ window.  This window is described in
the section ‘Print Control Panel.’

Close:
This selection will close the plot window.

View:
Full Screen:
Expands the plot to cover the full VPAS window.

Normal:
Reduces the plot to the original ‘windowed’ size.

Settings:
Color:
The color menu items shown below can be individually changed to suit
the users preference.  Any color item that is changed will be reflected in
all of the plot windows.  They cannot be selected individually.  Any
color changes will be store in the currently selected ‘Setup’ file (shown
after the VPAS title in the title bar).  In addition, the traces have
different styles to help see them, especially in printouts.

Channel 1 Trace (Style:  Solid)
Channel 2 Trace (Style:  Dot)
Channel 3 Trace (Style:  Dash)
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Channel Summation Trace (Style:  Dash Dot Dot)
Channel Neutral Trace (Style:  Dash Dot)
Trace Background
Frame
Grid
Cursor
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6. PRINT CONTROL PANEL

This printing utility for Graphs, Plots, and the Harmonic Bar Spectrum utilizes the
Bitmap graphical format to generate the printouts.  This allows the user to generate
very high resolution printouts.

The drawback is that this printing technique is relatively slow and very memory
intensive.  Fortunately or unfortunately, this is the only printing technique that is
supported by the development language used to create VPAS.  There will likely be
times when the user is not able to control all aspects of their printer from the Print
Control Panel.

If this occurs, the actual printer setting must be manipulated via the Control Panel
in Windows 3.X and via the Properties menu item in Windows 95.  This procedure
is described below under ‘Additional Print Control’.

Orientation:
This toggle switch will allow the user to choose ‘Portrait’ or ‘Landscape’
printing orientation.

Eject Page After Print?:
This toggle switch will allow the user to choose to eject the current printed
page upon print completion or to print without ejecting.

This can be useful if the user wants to print a small plot on the Bottom of the
page and print some text results on top.  This would be accomplished by
setting a ‘Custom’, ‘Placement / Size’ described in detail below.

Note: When text is printed, it will always start at the top of the page,
therefore if the user places a small plot on the top of the page while
choosing ‘No’ for ‘Eject Page’, the plot will be printed on top of the text
and will most likely be unreadable.

Placement / Size:
This toggle switch will allow the user to choose to print the plot across the
‘Full Page’ or to set a ‘Custom’ placement and size.  To set a ‘Custom’
placement and size, toggle the switch to ‘Custom.’  At this point two new
windows will open.
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Size Configuration: (in the upper left hand corner)

Paper Size:
This drop down box allows the user to choose the size of the paper
installed in the attached printer.  This will not default to paper size
currently set in Windows.  As this value is changed, the white ‘paper’
window is re-sized.

ACCEPT:
This button accepts the current position and size of the plot on the
‘Paper’ window and returns the user back to the ‘Print Control Panel’
window.

CANCEL:
This button discards any changes that have been made on the plot
position and size and returns the user back to the ‘Print Control Panel’.

Size the plot:
Using the mouse, click and hold the mouse button on any position of
the border of the plot and move the mouse to size the plot.

Move the plot:
Click and hold the mouse button on the title bar labeled ‘MOVE’ and
move the mouse to change the placement of the plot on the paper.

Resolution:
If the ‘Auto / Manual’ switch is set to ‘Auto’, VPAS will attempt to set the
dpi resolution to be the same as is currently set in Windows.

There are times where this is not possible.  If the printout is not what was
expected, such as if it should have been a full page and instead it is spread out
on 4 pages, than ‘Auto’ cannot be used.  In this case, the user must set the
toggle switch to the ‘Manual’ position and manually enter the Windows
printer dpi setting into the ‘dpi’ box.  See the section below titled ‘Additional
Print Control’.

Shading:
This drop down box will allow the user to print in ‘Black and White’, ‘Gray
Scale’ or ‘Color’.

Be warned that ‘Grayscale’ and ‘Color’, although they look great, will take
substantially longer than ‘Black and White’ printing.  Not only is ‘Black and
White’ printing much faster, it is typically easier to read.  Depending on the
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type of PC, the ‘Shading’ setting, and the ‘Print Quality’ setting printouts
could take in excess of 10 minutes.  A typical ‘Black and White’ printout
with a medium ‘Print Quality’ will usually take about a minute.  ‘Grayscale’
and ‘Color’ printouts with high ‘Print Quality’ settings can cause insufficient
memory errors.

This is typically due to the development language interface and the amount of
memory (especially conventional memory) that is already used by other
drivers and applications.  Freeing up conventional memory can resolve
insufficient memory errors.  Installing additional memory will typically have
no affect on the error.  A computer with 128Meg. of memory could fail where
a computer with 8Meg. may pass all depending on the driver configuration.

Another way of solving this problem is to reduce the ‘Print Quality’ setting (5
gives a decent printout).  A good rule of thumb is that a PC with 16M should
be used when printing color or grayscale plots.

Print Quality:
A print quality of 1 will yield a fairly blocky low resolution printout where
the axis values may be difficult to read but is very fast to print.  The highest
setting (25 in Black and White and 11 in Grayscale and Color) will yield very
clear high resolution printout but will be slow.  Due to memory issues, Black
and White is capable of printing the highest resolution.  For memory
problems, read the section above titled ‘Shading’.

PRINT:
Pressing the print button will spool the printout to the printer.

CLOSE:
Pressing this button will cancel the print request and close the ‘Print Control
Panel’ window.

Additional Print Control:

Windows 3.X:
To manually change print settings outside of VPAS, open the ‘MAIN’
folder on the Windows desktop by double clicking on it.  Next, open the
‘Control Panel’ icon within the ‘MAIN’ folder by double clicking on it.
Double click on the ‘Printers’ icon to open the printer setup utility.
Single click on the printer currently being used from the printer list.
Click on the ‘Setup’ button to open the printer options utility.  This
utility allows the user to change settings such as color printouts versus
monochrome, dpi settings, etc.
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Windows 95:
Click on the ‘Start’ button.  Choose the ‘Settings’ menu item then the
‘Printers’ menu item.  With the left mouse button, single click on the
printer icon currently being used (this will not open any utility
windows), then click the right mouse button and select the ‘Properties’
menu item to open the printer options utility.  This utility allows the user
to change settings such as color printouts versus monochrome, dpi
settings, etc.
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7. HELP

About:
This menu item will display the version of VPAS and various Voltech phone
numbers.

Help Tips:
This menu item will display a small scrolling box that gives brief instruction on
how to start taking readings.  This window can be checked, while open, to be show
every time VPAS is run.

On-Line Manual:
This menu item will display an OnLine version of the VPAS manual.
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